
Product description 

Repetitive sequences of the non-coding areas on human chromosomes - also called 
Short Tandem Repeats (STR) - are used in kinship testing and forensic science.  
The majority of the STRs are located on the autosomes, i.e. on the 22 chromosome 
pairs which are equivalent in both sexes.  
 
Autosomal markers are helpful in solving most of the forensic tasks in DNA analysis. 
However, some of them need the implementation of STRs on the sex chromosomes 
(gonosomes). Gonosomal STR markers are helpful in the investigation of relationships 
among individuals of different generations, especially when key persons of the 
pedigree are missing. Furthermore the use of gonosomal STRs in the analysis of DNA 
traces in forensic purposes is strongly rising.  
 
The Mentype® Argus X-8 contains the primers of Amelogenin (AM) for gender- 
determination, DXS7132, DXS7423, DXS8378, DXS10074, DXS10101, DXS10134, 
DXS10135, and HPRTB. Two markers belong to one of the four coupling groups of 
the X-chromosome (Fig. 1), so that two markers of each group have to be handled as 
haplotype for genotyping. The primers are fluorescence-labelled with 6-FAM or HEX. 
 
The detection limit of Mentype® Argus X-8 PCR Amplification Kit is about 100 pg 
genomic DNA. However, it is recommended to use 0.1-1.0 ng DNA. 
 
The Mentype® Argus X-8 supplements the Mentype® Argus Y-MHQS for kinship and 
paternity testing especially in complicated deficiency cases whereas all important 
population-genetic data can be calculated with the GenoProof® Software. 
 
 
The Forensic ChrX Research Group initiated the online data base ChrX-STR.org 
(http://www.chrx-str.org) that calculates population-genetic data on basis of  
X-chromosmal allele frequencies (Szibor et al., 2006).  
 
Generation of DNA profiles using Mentype® Argus X-8 conforms to the guidelines of:  
- the European DNA Profiling Group (EDNAP), www.isfg.org/EDNAP 
- the International Society for Forensic Genetics (ISFG), www.isfg.org 
- the Scientific Working Group on DNA Analysis Methods (SWGDAM),  
  www.fbi.gov/hq/lab/fsc/backissu/july2004/standards/2004_03_standards02.htm  
 
The test kit was validated and evaluated using the GeneAmp® 9700 thermal cycler, 
ABI PRISM® 310 Genetic Analyzer, and ABI PRISM® 3100/3130 Genetic Analyzer. 
 

Mentype® Argus X-8 PCR Amplification Kit 
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Fig. 1 The Ideogram of the X-chromosome describes the physical localisation of the forensic STRs, which can 
be analysed with the Mentype® Argus X-8. Distances from the p-telomere are shown in Mb 
(http://www.ncbi.nlm.nih.gov/genome/guide/human as at 10/2005). The markers are linked as follows: 
DXS8378 and DXS10135, DXS7132 and DXS10074, HPRTB and DXS10101 as well as DXS7423 and 
DXS10134. Also Amelogenin X and DXS8378 or DXS10135 are in tight neighbourhood, but without relevance 
for investigations of transmission because Amelogenin X and Amelogenin Y do not show any length 
polymorphisms and are not responsible for calculation of the likelihood. 
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Table 1. Locus-specific information of Mentype® Argus X-8 
Locus GenBank® 

Accession 
Repeat motif 
of the reference allele 

Reference 
allele 

Allele 
range 

Amelogenin X M55418    
Amelogenin Y M55419    
DXS7132 G08111 [TCTA]13 13   8-19 
DXS7423 AC109994 [TCCA]3 TCTGTCCT [TCCA]12  15   8-19 
DXS8378 G08098 [CTAT]12 12   7-15 
DXS10074 AL356358 [AAGA]14 14   4-21 
DXS10101 AC004383 

 
[AAAG]3 GAAAGAAG [GAAA]3 
A [GAAA]4 AAGA [AAAG]5 
AAAAAGAA [AAAG]13 AA 

28.2 24-36 

DXS10134 AL034384 [GAAA]3 GAGA [GAAA]4 AA 
[GAAA] GAGA [GAAA]4 GAGA 
[GACAGA]3 [GAAA] GTAA 
[GAAA]3 AAA [GAAA]4 AAA 
[GAAA]15 

35 28-44.3 

DXS10135 AC003684 [AAGA]3 GAAAG [GAAA]20 23 13-39.2 
HPRTB M26434 [AGAT]12 12   7-19 

* [AGAT] is the common repeat structure, for variations see NIST and Szibor et al. 2009. 
 
Table 1 shows the STR loci with their repeat motifs and alleles that are concordant with 
the International Society for Forensic Genetics (ISFG) guidelines for the use of 
microsatellite markers (Bär et al., 1997). The most frequent alleles for European 
populations are included in the allelic ladder. The nomenclature for X-STR Loci 
DXS7132, DXS7423 and DXS8378 is in accordance with Szibor et al. (2003a). The 
nomenclature of DXS10074, DXS10101, DXS10134 und DXS10135 is in accordance 
with Becker et al. (2008). Allele ranges include all known alleles of the current literature 
as at 12/2008. 
 
 
Table 2. Chromosomal mapping of Mentype® Argus X-8 

Locus Chromosomal mapping   
Amelogenin X Xp22.1-22.3   
Amelogenin Y Yp11.2   
DXS7132 Xq11.2   
DXS7423 Xq28   
DXS8378 Xp22.31   
DXS10074 Xq12   
DXS10101 Xq26.2   
DXS10134 Xq28   
DXS10135 Xp22.31   
HPRTB Xq26.2   
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Content 

Mentype® Argus X-8 PCR Amplification Kit (100 Reactions) 
Nuclease-free water 3.0 mL 
Reaction mix A 500 μL 
Primer mix 250 μL 
DNA polymerase 40 μL 
Control DNA XY1 (2 ng/μL) 10 μL 
Control DNA XX28 (2 ng/μL) 10 μL 
DNA Size Standard 550 (ROX) 50 μL 
Allelic ladder  10 μL 
 
 

Ordering information 
Mentype® Argus X-8 25 reactions Cat. No. 43-09110-0025 
Mentype® Argus X-8 100 reactions Cat. No. 43-09110-0100 
Mentype® Argus X-8 400 reactions Cat. No. 43-09110-0400 

 
 
Storage 

Store all components at –20°C and avoid repeated thawing and freezing. Primer mix 
and allelic ladder must be stored protected from light. The DNA samples and post-PCR 
reagents (allelic ladder and DNA size standard) should be stored separately from the 
PCR reagents. The expiry date is indicated on the kit cover.  
 
 
Quality assurance 

All kits components undergo an intensive quality assurance process at Biotype 
Diagnostic GmbH. The quality of the test kits is permanently monitored in order to 
ensure unrestricted usability. Please contact us if you have any questions regarding 
quality assurance.  
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Additionally required reagents 

Additional reagents are needed in order to use the Biotype® PCR Amplification Kit: 
Reagent Supplier Order number 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards DS-30 
for ABI PRISM® 310 Genetic Analyzer Applied Biosystems 401546 and 402996 (NED) 

Matrix Standards DS-30 
for ABI PRISM® multi-capillary instruments Applied Biosystems 4345827 

 
 
Trademarks and patents 

Mentype® is a registered trademark of Biotype Diagnostic GmbH. 
GenoProof® is a registered trademark of Qualitype AG. 
ABI PRISM®, GeneScan®, Genotyper®, GeneMapper™ and Applied Biosystems are 
registered trademarks of Applied Biosystems Inc. or its subsidiaries in the U.S. and 
certain other countries. 
6-FAM, HEX, NED, ROX, POP-4 and Hi-Di are trademarks of Applied Biosystems Inc. 
GeneAmp® is a registered trademark of Roche Molecular Systems. 
The PCR is covered by patents. Patentees are Hoffmann-La Roche Inc. and 
F. Hoffmann-La Roche (Roche). 
GenBank® is a trademark of National Institute of Health. 
 
 
Warnings and safety instructions 

The PCR Amplification Kit contains the following potentially hazardous chemicals:  
Kit component Chemical Hazards 
Primer mix, reaction mix 
and allelic ladder 

Sodium azide NaN3 toxic if swallowed, develops toxic gases 
when it gets in contact with acids  

Observe the Material Safety Data Sheets (MSDS) for all Biotype® products, which are 
available on request. Please contact the respective manufacturers for copies of the 
MSDS for any additionally needed reagents. 



 

Mentype® Argus X-8 July 2010 

6 

Content 

1. PCR amplification .......................................................................................... 7 
1.1 Master mix preparation............................................................................ 7 
1.2 PCR amplification parameter.................................................................... 8 

2. Electrophoresis using the ABI PRISM® 310 Genetic Analyzer ........................... 9 
2.1 Matrix generation .................................................................................... 9 
2.2 Sample preparation............................................................................... 12 
2.3 Setting up the GeneScan® software ....................................................... 12 
2.4 Analysis parameter ............................................................................... 13 

3. Electrophoresis using the ABI PRISM® 3130/3130xl Genetic Analyzer ............ 14 
3.1 Spectral calibration / matrix generation................................................... 14 
3.2 Sample preparation............................................................................... 17 
3.3 Setting up the GeneMapper™ ID software ............................................. 18 
3.4 Analysis parameter / analysis method..................................................... 20 

4. Analysis...................................................................................................... 21 
4.1 Biotype® template files.......................................................................... 22 
4.2 Controls................................................................................................ 23 
4.3 Lengths of fragment and alleles ............................................................. 23 

5. Interpretation of results................................................................................ 28 
6. Population-genetic data ............................................................................... 29 
7. Usage of the X-chromosomal STRs and their characteristics .......................... 32 
8. References ................................................................................................. 34 
 



 

Mentype® Argus X-8 July 2010 

7 

1. PCR amplification 

1.1 Master mix preparation 
The table below shows the volumes of all PCR reagents per 25 μL reaction volume, 
including a sample volume of 1.0 μL (template DNA). The number of reactions to be 
set up shall be determined taking into account positive and negative control reactions. 
Add one or two reactions to this number to compensate the pipetting error. 
 
Component Volume 
Nuklease-free water 16.1 μL 
Reaction mix A* 5.0 μL 
Primer mix 2.5 μL 
Multi Taq2 DNA Polymerase (hot start, 2.5 U/μL) 0.4 μL 
Volume of master mix 24.0 μL 

* contains Mg2+, dNTPs, BSA 
 
All components should be mixed (vortex) and centrifuged for about 10 s before 
preparing the master mix. The DNA volume applied to the assay depends on its 
concentration. A volume of up to 5 μL may be necessary for DNA trace templates. DNA 
volumes of more than 5 μL are not recommended, because potential PCR inhibitors 
may interfere with the process. Fill up the final reaction volume to 25 μL with 
nuclease-free water. 
 
Generally, DNA templates shall be stored in nuclease-free water or in diluted TE buffer 
(10 mM Tris HCl, pH 8.0 and 1 mM EDTA), e.g. 0.1x TE buffer. 
 
The primer mixes are adjusted for balanced peak heights at 30 PCR cycles and 
0.2 ng Control DNA XX28 in a reaction volume of 25 μL. If more DNA template is 
introduced, higher peaks can be expected for small PCR fragments and relatively low 
peaks for large fragments. Reduce the amount of DNA template to correct this 
imbalance. 
 
 
Positive control 

For the positive amplification control, dilute the Control DNA XX28 to 0.2 ng in the 
appropriate volume. Instead of the template DNA pipette the diluted Control DNA into a 
reaction tube containing the PCR master mix. 
 
Negative control 

For the negative amplification control, pipette nuclease-free water instead of template 
DNA into a reaction tube containing the PCR master mix. 
 
Template DNA 

Sometimes, the measured value of the DNA concentration varies depending on the 
quantification method used, so that it may be necessary to adjust the optimal DNA 
amount. 

Protocols for PCR amplification, electrophoresis, and analysis



 

Mentype® Argus X-8 July 2010 

8 

1.2 PCR amplification parameter 

Perform a “hot start” PCR in order to activate the Multi Taq2 DNA Polymerase and to 
prevent the formation of non-specific amplification products. 
 
The number of cycles depends on the amount of DNA. 30 cycles are recommended for 
all samples. For critical stains (< 100 pg DNA), it is recommended to increase the 
number of PCR cycles from 30 to 34. 

Standard method 

Recommended for all DNA samples  
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
58°C 120 s 
72°C 75 s 

30 cycles 

68°C 60 min  
10°C ∞ hold 
 

Optional 
Recommended for stains with small amounts of DNA 
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
58°C 120 s 
72°C 75 s 

34 cycles 

68°C 60 min  
10°C ∞ hold 
 
 
Too small amounts of DNA may result in allelic dropouts and imbalances of the peaks. 
Furthermore, unspecific amplification products could appear. With increasing numbers 
of cycles, there is the risk of cross contamination caused by minimal amounts of 
impurities. 
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2. Electrophoresis using the ABI PRISM® 310 Genetic Analyzer 

For general instructions on instrument setup, matrix generation and application of the 
GeneScan® or GeneMapper™ ID software, refer to the ABI PRISM ® 310 Genetic 
Analyzer User’s Manual. Electrophoresis by using the GeneScan® software is described 
below. 
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). Generally, Filter Sets A and F 
are suitable, too.  
 
Material  
Capillary 47 cm / 50 μm (green) 
Polymer POP-4 for 310 Genetic Analyzer  
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

2.1 Matrix generation  

Prior to conducting DNA fragment size analysis with the filter set D, a matrix with the 
four fluorescent labels 6-FAM, HEX, NED, and ROX must be generated. The suitable 
matrix standard DS-30 is available from Applied Biosystems. 
 
Colour Matrix standard Order number 
Blue (B) 6-FAM Applied Biosystems, 401546 
Green (G) HEX Applied Biosystems, 401546 
Yellow (Y) NED Applied Biosystems, 402996 
Red (R) ROX Applied Biosystems, 401546 
 
Four electrophoresis runs shall be conducted, one for each fluorescent label, 6-FAM, 
HEX, NED, and ROX, under the same conditions as for the samples and allelic ladders 
of the Biotype® test kit to generate suitable matrix files. 
 
Matrix sample Component Volume 

Hi-Di™ Formamide 12.0 μL 
Matrix sample 1 

Matrix standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 2 

Matrix standard HEX 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 3 

Matrix standard NED 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 4 

Matrix standard ROX 1.0 μL 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
- For analysis: load the samples on the tray 
 
- Create a Sample Sheet and enter sample designation 
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Injection list for matrix generation 
Parameter Set up 
Module File GS STR POP-4 (1 ml) D 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* prepare matrix standards always without DNA Size Standard (ROX)  
 

Analysis of the matrix samples 

- Run the GeneScan® software 
- File → New → Project (open folder of current run) → Add Sample Files 
- Select a matrix sample in the Sample File column  
- Sample → Raw Data 
- Check the matrix samples regarding a flat baseline. As shown in the figure below, 

there should be at least five peaks with peak heights about 1000-4000 (Y-axis) for 
each matrix sample (optimal range: 2000-4000) 

 

 
Fig. 2 Electropherogram with raw data of the matrix standard 6-FAM 
 
- Select analysis range with flat baseline and re-inject the matrix sample if necessary 
- Note down start and end value (data points) of the analysis range, e.g.  
   start value 3400, end value 6400 
- Calculate the difference, e.g. 6400-3400 = 3000 data points 

 ▼ 3400 Data Points (X) 
 

 6400▼ 
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Generation of a new matrix 

- File → New → Matrix 

 
Fig. 3 Matrix sample selection 
 
- Import matrix samples for all dyes (B, G, Y, R) 
- Enter a Start At value, e.g. 3400 
- Enter the calculated difference under Points, e.g. 3000 
- Click on OK to calculate the new matrix 
 

 
Fig. 4 New matrix DS-30 

 
- Save the matrix in the matrix folder: File → Save as, e.g. Matrix DS-30 
 
 
Matrix check 

Check the new matrix with current samples. 
- File → New → Project (open folder of the respective run) → Add Sample Files 
- Select sample(s) in the Sample File column  
- Sample → Install New Matrix (open matrix folder and select new matrix) 
- Re-analyse your samples 
 
There should be no pull-up peaks between the dye panels (B, G, Y, R) with the new 
matrix. 
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2.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX) 0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples  
add 1 μL PCR product (diluted if necessary) or allelic ladder  
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of  

about 500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
 
 

2.3 Setting up the GeneScan® software  

- Create a Sample Sheet and enter sample designation 
 
Injection list 
Parameter Set up 
Module File GS STR POP-4 (1 ml) D 
Matrix File e.g. Matrix DS-30 
Size Standard e.g. SST-ROX_50-400bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 26 

* Deviating from standard settings, the injection time may range between 1 and 10 s depending on the type of 
sample. If blood samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time up to 10 s may be necessary.  

 
** Depending on the analysis conditions the run time for Mentype® Argus X-8 was modified in order to analyse 
fragments with lengths of up to 400 bp. 
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2.4 Analysis parameter 

The recommended analysis parameters are: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynorminal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 50 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneScan® or GeneMapper™ ID software. Thresholds are usually 50-200 RFU and should be determined 
individually by the laboratory. Recommendation: The minimal peak height should be three times as high as the 
background noise of the baseline. 

 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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3. Electrophoresis using the ABI PRISM® 3130/3130xl Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, or application of the 
ABI PRISM® Data Collection software version 3.0 and the GeneMapper™ ID software, 
refer to the ABI PRISM ® 3130/3130xl Genetic Analyzers Getting Started Guide.  
 
The system with 4 capillaries is named ABI 3130 (former ABI 31300-Avant), and the 
system with 16 capillaries is named ABI 3130xl (former ABI 31000).  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). 
 
Material  
Capillary 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

3.1 Spectral calibration / matrix generation 

Prior to conducting DNA fragment size analysis, it is necessary to perform a spectral 
calibration with the four fluorescent labels 6-FAM, HEX, NED, and ROX for each 
analyzer. The calibration procedure creates a matrix which is used to correct the 
overlapping of fluorescence emission spectra of the dyes.  
 
Spectral calibration comprises the following steps: 
- Preparation the spectral calibration standards 
- Loading the standards to the 96-well reaction plate (one sample per capillary) 
- Creating the instrument protocol for spectral calibration (Protocol Manager) 
- Defining the plate composition in the plate editor (Plate Manager) 
- Performing a spectral calibration run and checking the matrix 
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Setting up the spectral calibration standards 
Example for 4 capillaries/ABI 3130 
Component Volume 
Hi-Di™ Formamide 47.5 μL 
Matrix standard DS-30 2.5 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-D1 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Example for 16 capillaries/ABI 3130xl 
Component Volume 
Hi-Di™ Formamide 190.0 μL 
Matrix standard DS-30 10.0 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-H1 and A2-H2 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Performing spectral calibration run 

- Place the 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software click New the window 

Instrument Protocol to open the Protocol Editor dialog box 
 
 
Instrument Protocol for spectral calibration 
Protocol Editor Set up 
Name User (e.g. Spectral36_POP4_DS30) 
Type SPECTRAL 
Dye Set D 
Polymer* User (e.g. POP4) 
Array Length* User (e.g. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (e.g. Spect36_POP4_1) 

* Depends on the type of polymer and length of capillary used 
 
- Select OK to complete the Protocol Editor dialog box 
- In the Plate Manager of the Data Collection software click New to open the New  
  Plate Dialog box 
 
Plate Editor for spectral calibration (I) 
New Plate Dialog Set up 
Name e.g. Spectral_DS-30_date 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click on OK. A new table in the Plate Editor opens automatically 
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Plate Editor for spectral calibration (II) 
Parameter Set up 
Sample Name Type name for the matrix samples 
Priority  e.g. 100  
Instrument Protocol 1 Spectral36_POP4_DS30 (setting described earlier) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples, and click on OK 
- In the Run Scheduler click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run 
 

 
Fig. 5 Electropherogram of spectral calibration with matrix standard for DS-30 on an ABI 3130 

 
 
Matrix check 

- The quality value (Q value) of each capillary must be greater than 0.95 and the  
   condition number range (C value) must be between 1 and 20. 
- Check the matrix samples for a flat baseline. As shown in the figure above, there 

should be four peaks with peak heights of about 1000-5000 (Y-axis) in each matrix 
sample (optimal range: 2000-4000) 

- Check the new matrix with your current samples. There should be no pull-up peaks 
between the dye panels (B, G, Y, R, O) with the new matrix 

- If calibration was not successful, use the optimised values and repeat the calibration 
run 

- If all capillaries have passed the test, the last calibration file for the Dye Set D is 
activated automatically in the Spectral Viewer. Rename the calibration file (e.g. 
DS-30_Date of calibration) using the respective button 

        R, Y,   G,     B 
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3.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX)   0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples 
add 1 μL PCR product (diluted if necessary) or allelic ladder 
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples must be 
pipetted on the plate of multi-capillary analysers. If fewer samples are analysed, the 
empty positions must be filled with 12 μL Hi-Di™ Formamide. 
 
To ensure a reliable allelic assignment on multi-capillary analysers, a number of allelic 
ladders should be run, independently from sample number. 
 
Room temperature may influence the performance of PCR products on multi-capillary 
instruments, so that shoulder peaks or split peaks occur especially at low 
temperatures. Pay attention to keeping ambient conditions as recommended by the 
instrument manufacturer. 
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of about 

500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
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3.3 Setting up the GeneMapper™ ID software 

Edit the Run Module as follows for the first run: 
- In the Module Manager of the Data Collection software click on New to open the 

Run Module Editor dialog box 
 
Run Module 3kV_10s_400bp 
Parameter Set up 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 1200 

* Deviating from the standard settings, the injection time may range between 1 and 20 s depending on the type 
of sample. If samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time of up to 20 s may be necessary.  
 
** Depending on the analysis conditions the run time for Mentype® Argus X- was modified in order to be able 
to analyse fragments with lengths of up to 400 bp. 
 

- Click on Save As, enter the name of the new module (e.g. 3kV_10s_400bp) and confirm 
with OK 

- Click on Close to exit the Run Module Editor 
 
 
Starting the run 

- Place the prepared 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software, click on New in the 

Instrument Protocol window to open the Protocol Editor dialog box 
 

Instrument Protocol 
Protocol Editor Set up 
Name e.g. Run36_POP4_DS-30_20min 
Type REGULAR 
Run Module* 3kV_10s_400bp 
Dye Set D 

* parameter see above 
 
- Click on OK to exit the Protocol Editor 
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Prior to each run, it is necessary to create a plate definition as follows: 
- In the Plate Manager of the Data Collection software click on New to open the 

Plate Dialog box 
 
GeneMapper™ Plate Editor (I) 
New Plate Dialog Set up 
Name e.g. Plate_DS-30_Date 
Application select GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click OK. A new table in the Pate Editor opens automatically 
 
GeneMapper™ Plate Editor (II) 
Parameter Set up 
Sample Name Type name for the samples 
Priority  e.g. 100 (Default) 
Sample Type Sample or Allelic Ladder 
Size Standard e.g. SST-ROX_50-400bp 
Panel e.g. Biotype_Panels_ v3a (choose test kit) 
Analysis Method e.g. Analysis_HID_3130 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (select results group) 
Instrument Protocol 1 Run36_POP4_DS-30 (setting described earlier) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples and click on OK 
- In the Run Scheduler, click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run  
- During the run, view Error Status in the Event Log or examine the quality of the raw 

data for each capillary in the Capillaries Viewer or the Cap/Array Viewer 
- View data as overview in Run History or Cap/Array Viewer of the Data Collection 

software. Run data are saved in the Run Folder of the previously chosen Result 
Group 
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3.4 Analysis parameter / analysis method 

The recommended settings in the worksheet Peak Detector are: 
 
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2000; Stop Pt: 10000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 
Slope Thresholds: 0.0 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneMapper™ ID software. The thresholds are usually 50-200 RFU and should be determined individually 
by the laboratory. Recommendation: The minimal peak height should be three times as high as the background 
noise of the baseline. 
 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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4. Analysis 

For general instructions on automatic sample analysing, refer to the GeneScan® or 
GeneMapper™ ID Software User’s Manual.   
 
Finding the exact lengths of the amplified products depends on the device type, the 
conditions of electrophoresis, as well as the DNA size standard used. Due to the 
complexity of some loci, determining the size should be based on evenly distributed 
references. The DNA Size Standard 550 (ROX) shall thus be used with the following 
lengths of fragments: 50, 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 
240, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 525, and 550 
bp.  
 

 
Fig. 6 Electropherogram of the DNA Size Standard 550 (ROX), fragments with lengths in bp 

 
 
Note: The basic template files for the DNA Size Standard 550 (ROX) has to be adjusted 
to 400 bp within the GeneMapper™ ID software. The new template could be saved as 
e.g. SST-ROX_50-400bp and used for further analyses.  
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4.1 Biotype® template files 

Allele allocation should be carried out with a suitable analysis software, e.g. 
GeneMapper™ ID or Genotyper® software in combination with the Mentype®  
Argus X-8 template files from Biotype. Template files are available from our 
homepage or as CD-ROM on request.  
 

Recommended Biotype® templates for GeneMapper™ ID/ID-X software are: 
Panels Biotype_Panels_v3a/v3X (choose kit) or higher versions 
BinSets Biotype_Bins_ v3a/v3X or higher versions 
Size Standard SST-ROX_50-500bp (adjust up to 400bp, adjustment described earlier) 
Analysis Method Analysis_HID_310  
 Analysis_HID_3130  
 Analysis_HID_310_50rfu  
 Analysis_HID_3130_50rfu  
Plot Settings Plots_3dyes  
Table Settings Table for 2 alleles   
 Table for 10 alleles  
 
Panels and BinSets always have to be used whereas the other template files are 
optional.  
 

Additional Biotype® templates for GeneMapper™ ID-X Software: 
Stutter* Biotype_Stutter_v3X or higher version 

* When loading the above mentioned panels, the stutter settings will not be accepted. Thus, the stutter data has 
to be imported separately.  
 

Recommended Biotype® template files for Genotyper® software are:  
Argus X8_v1a or higher versions 
 
 
General procedure for the analysis 

1. Check the DNA size standard 
2. Check the allelic ladder 
3. Check the positive control 
4. Check the negative control 
5. Analyse and interpret the sample data 
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4.2 Controls 

The control DNA XY1 and XX28 of the test kit, and other commercially available DNA 
from standard cell lines, represent the following alleles: 
 
Table 3. Allele assignment of Mentype® Argus X-8 

Locus Control  
DNA XY1 

Control  
DNA XX28 

ATCC 
K-562 

CCR 
9947A 

CCR 
9948 

CCR 
3657 

Amelogenin X / Y X / X X / X X / X X / Y X / Y 
DXS7132 13 13 / 14 13 / 13 12 / 12 13 12 
DXS7423 15 14 / 15 17 / 17 14 / 15 14 13 
DXS8378 12 10 / 12 10 / 10 10 / 11 11 12 
DXS10074 16 18 / 20 17 / 17 16 / 19 18 7 
DXS10101 32 28.2 / 28.2 31 / 31 30 / 31 32 29.2 
DXS10134 38 36 / 38.3 32 / 32 35 / 36 34 34 
DXS10135 24 16 / 30 27 / 27 21.1 / 27 22 25 
HPRTB 16 12 / 13 13 / 13 14 / 14 14 13 
 
For further confirmation, the table above displays the alleles of the reference DNA 
purchased from ATCC (http://atcc.org/Produtcs/PurifiedDNA. cfm#celllines) as well as 
three reference DNA purchased from Coriell Cell Repositories (CCR; 
http://locus.umdnj.edu/nigms/) that is up to standard of Szibor et al. (2003c). 
 
 

4.3 Lengths of fragment and alleles 

Table 4 and Table 5 show the fragment lengths of individual alleles that refer to the 
DNA Size Standard 550 (ROX). All analyses have been performed on an 
ABI PRISM® 310/3130 Genetic Analyzer with POP-4 polymer. Different analysis 
instruments, DNA size standards or polymers may result in different fragment lengths.  
In addition, a visual alignment with the allelic ladder is recommended. 
 
 
Scaling 

Horizontal: 85-405 bp 
Vertical:  Depending on signal intensity 
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Figure 7 
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Figure 8 
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Fig. 8 Electropherogram of the allelic ladder Mentype® Argus X-8 analysed on an ABI PRISM® 310 Genetic Analyzer with 
the DNA Size Standard 550 (ROX). Allele assignment was performed using the Genotyper® software and the Mentype® 
Argus X-8 template files. 
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Table 4. Fragment lengths of the allelic ladder Mentype® Argus X-8 analysed on an 
ABI PRISM® 310/3130 Genetic Analyzer (blue panel) 
 
Marker/Allele Size [bp]* Further  

alleles** Marker/Allele Size [bp]* Further  
alleles** Marker/Allele Size [bp]* Further  

alleles** 

Amelogenin 6-FAM  DXS7423 6-FAM  DXS10134 6-FAM  

X 103  13 233 12 31 330 28, 29, 30, 31.1 

Y 109  14 237  32 334 32.1 

   15 241  33 338 33.1 

DXS8378 6-FAM  16 245  34 342  

  9 154 8 17 249  35 346 35.3 

10 158  18 253  36 350  

11 162     37 354 37.2, 37.3 

12 166  DXS7132 6-FAM  38 358 38.2 

13 170  11 281 10 38.3 360  

14 174  12 285  39.3 364 39, 39.2 

15 178  13 289  40.3 368 40 

   14 293  41.3 372 41 

HPRTB 6-FAM  15 297  42.3 376  

  9 190 8 16 301  43.3 380  

10 194  17 305  44.3 384  

11 198        

11.2 200        

12 202        

13 206        

14 210        

15 214        

16 218        

17 222        

         

 



 

Mentype® Argus X-8 July 2010 

27 

Table 5. Fragment lengths of the allelic ladder Mentype® Argus X-8 analysed on an  
ABI PRISM® 310/3130 Genetic Analyzer (green panel) 

 
Marker/allele Size [bp]* 

Further 
alleles**  Marker/allele Size [bp]* 

Further 
alleles**  Marker/allele Size [bp]* 

Further 
alleles** 

DXS10074 HEX  DXS10101 HEX  DXS10135  HEX  

  4 98  24.2 185 24, 25, 25.2 16 242 14, 16.1 

  7 110  26.2 193 26 17 246 17.1 

  8 114  27 195  18 250 18.1 

  9 119  27.2 197  19 254 19.1 

12 132 10, 11 28 199  20 258 20.1 

13 136  28.2 201  21 262 21.1 

14 140 14.3 29 203  22 266 22.1 

15 144  29.2 205  23 269 23.1 

16 148  30 207  24 273 24.1, 24.2 

16.2 150  30.2 209  25 277 25.1 

17 152  31 211  26 281 26.1 

18 156  31.2 213  27 285  

19 160 19.3 32 215  28 289 28.1 

20 164  32.2 217  29 293  

21 168  33 219  30 296  

   33.2 221  31 300  

   34 223 34.2, 35 32 304 32.1, 33.1 

      34 312 34.1 

   
  

 35 316 35.1, 35.2, 
36, 37.2, 39.2 

         

* rounded to integer 

** The “off-ladder” alleles of Biotype’s DNA pool are allocated with the actual Biotype® template files for GeneMapper™ 
ID or Genotyper® software. For further alleles see amongst others http://www.cstl.nist.gov/biotech/strbase/str_fact.htm  
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5. Interpretation of results 

As mentioned above, post PCR analysis and automatic allele assignment with 
suitable analysis software ensure a precise and reliable discrimination of 
alleles. 
 
Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(>3000 RFU), or if an incorrect matrix was applied. They appear at positions of 
specific peaks in other colour channels, typically with lower signal intensities. 
Peak heights should not exceed 3000 RFU in order to prevent pull-up peaks.  
 
Stutter peaks 

The occurrence of stutter peaks depends on the sequence of the repeat 
structure and the number of alleles. n-4 peaks are caused by a loss of a repeat 
unit during amplification of tetranucleotide STR motives, caused by slippage 
effects of the Taq DNA Polymerase. Interpretation of those peaks should be 
done in accordance with the Template Files of the Genotyper® and 
GeneMapper™ ID software. 
 
Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA Polymerase tends to 
add an adenosine radical at the 3’-end of the amplified DNA fragments. The 
artefact peak is one base shorter than expected (-1 peaks). All Biotype® 
primers are designed to minimise these artefacts. Artefact formation is further 
reduced by the final extension step of the PCR protocol at 68°C for 60 
minutes. Peak height of the artefact correlates with the amount of DNA. 
Laboratories should define their own limits for analysis of the peaks. 
 
Artefacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder 
or split peaks appear, we recommend injecting the sample again. 
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6. Population-genetic data 

The most important data for the X-STR marker of the test kit are listed in table 
6-8. The formula for calculation of the “Polymorphism Information Content” 
(PIC) was published by Botstein et al. (1980), the one for the “Expected 
Heterocygosity” (HET) by Nei and Roychoudhury (1974). Both can be used for 
autosomal or X-chromosomal marker. Krüger et al. (1968) introduced the 
formula for the “Mean Exclusion Chance“ MECKrüger which was developed for 
either autosomal marker or for trios. With exception of deficient cases, 
MECKrüger is not suitable for X-chromosomal marker. Here, the paternal 
grandmother can be analysed instead of the putative father. Kishida et al. 
(1997) devised the MECKishida for X-chromosomal marker in consideration of 
trios including a daughter. In comparison with MECKrüger, MECKishida is more 
complex which highlights the fact that in trios involving a daughter X-STRs are 
more efficient then autosomal markers. Finally, Desmarais et al.(1998) 
introduced formulae for the “Mean Exclusion Chance“ of ChrX markers in trios 
involving daughters as well as in father-daughter duos without information 
about the maternal genotype. MECDesmarais is equivalent to MECKishida whereas 
MECDesmarais Duo can also be used for maternity testing of mother-son duos. The 
formula for calculation of the “Power of Discrimination“ (PD) erfolgt nach 
Desmarais et al. (1998). 
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for deficiency cases (mother, daughter, putative grandmother): 

MECKrüger = Σi fi
3 (1 - fi)

2 + Σi fi (1 - fi)
3 + Σi<j fi fj (fi + fj) (1- fi – fj )

2    

for trios (mother, daughter, putative father): 
MECKishida = Σi fi

3 (1 - fi) + Σi fi (1 - fi)
2 + Σi<j fi fj (fi + fj) (1- fi – fj )  

for trios (mother, daughter, putative father): 
MECDesmarais = 1 - Σi fi

2 + Σi fi
4 – (Σi<j fi

2)2  

for duos (putative father, daughter) : 
MECDesmarais Duo = 1 - 2Σi fi

2 + Σi fi
3 

PDfemale = 1 – 2(Σi fi
2)2 + Σi fi

4 

PDmale = 1 – Σi fi
2 

 
All important population-genetic data could be calculated with the GenoProof® 
software from Qualitype AG. 
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Table 6. Population-genetic data 

Marker DXS7132 Marker DXS7423 Marker DXS8378 

Allele Allele frequency* Allele Allele frequency* Allele Allele frequency* 

11 0.012 12 0.002   8 0.002 
12 0.089 13 0.077   9 0.046 
13 0.266 14 0.348 10 0.312 
14 0.379 15 0.356 11 0.332 
15 0.211 16 0.193 12 0.277 
16 0.036 17 0.022 13 0.029 
17 0.007 18 0.002 14 0.002 

      
PIC 0.687 PIC 0.656 PIC 0.658 
HET 0.733 HET 0.710 HET 0.714 
PDfemale 0.884 PDfemale 0.862 PDfemale 0.863 
PDmale 0.732 PDmale 0.709 PDmale 0.713 
MECKishida 0.687 MECKishida 0.656 MECKishida 0.658 
MECKrüger 0.497 MECKrüger 0.456 MECKrüger 0.454 
MECDesmarais  0.687 MECDesmarais  0.656 MECDesmarais  0.658 
MECDesmarais Duo  0.547 MECDesmarais Duo  0.512 MECDesmarais Duo  0.514 

* according to Edelmann et al., 2001 * according to Szibor et al., 2003a * according to Edelmann et al., 2001 
 
 
Table 7. Population-genetic data 

Marker DXS10074 Marker DXS10101 Marker DXS10134 

Allele Allele frequency* Allele Allele frequency* Allele Allele frequency* 

  7 0.066 26.2 0.025 30 0.001 
  8 0.135 27 0.011 31 0.002 
  9 0.014 27.2 0.025 32 0.008 
10 0.001 28 0.040 33 0.054 
13 0.005 28.2 0.148 34 0.107 
14 0.009 29 0.011 35 0.209 
15 0.070 29.2 0.120 36 0.222 
16 0.218 30 0.043 37 0.168 
16.2 0.002 30.2 0.152 37.2 0.002 
17 0.249 31 0.113 38 0.059 
18 0.149 31.2 0.106 39 0.035 
19 0.065 32 0.101 39.3 0.036 
20 0.013 32.2 0.047 40.3 0.044 
21 0.003 33 0.040 41.3 0.027 
  33.2 0.007 42.3 0.019 
PIC 0.816 34 0.011 43.3 0.006 
HET 0.837   44.3 0.001 
PDfemale 0.953 PIC 0.889   
PDmale 0.836 HET 0.902 PIC 0.844 
MECKishida 0.815 PDfemale 0.981 HET 0.858 
MECKrüger 0.675 PDmale 0.898 PDfemale 0.965 
MECDesmarais  0.816 MECKishida 0.889 PDmale 0.859 
MECDesmarais Duo  0.705 MECKrüger 0.793 MECKishida 0.836 

* according to Hering et al., 2006 MECDesmarais  0.889 MECKrüger 0.844 

 MECDesmarais Duo  0.807 MECDesmarais  0.842 
 * according to Rodig et al., submitted MECDesmarais Duo  0.741 

   * according to Edelmann et al., 2007 
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Table 8. Population-genetic data 

Marker DXS10135 Marker HPRTB 

Allele Allele frequency* Allele Allele frequency* 

16 0.004   9 0.010 
17 0.028 10 0.019 
18 0.040 11 0.116 
19 0.068 12 0.276 
20 0.072 13 0.322 
21 0.112 14 0.169 
22 0.108 15 0.076 
23 0.084 16 0.012 
24 0.108   
25 0.072 PIC 0.737 
26 0.100 HET 0.773 
27 0.060 PDfemale 0.913 
28 0.048 PDmale 0.772 
29 0.028 MECKishida 0.737 
30 0.028 MECKrüger 0.562 
31 0.028 MECDesmarais  0.737 
32 0.003 MECDesmarais Duo  0.605 
33 0.004   
    
PIC 0.916   
HET 0.925   
PDfemale 0.988   
PDmale 0.921   
MECKishida 0.911   
MECKrüger 0.835   
MECDesmarais  0.916   
MECDesmarais Duo  0.850   

* according to R. Szibor, pers. communication * according to Edelmann et al., 2001 
 
The Forensic ChrX Research Group initiated the online data base “ChrX-
STR.org” (http://www.chrx-str.org) that calculates population-genetic data on 
the basis of X-chromosmal allele frequencies (Szibor et al., 2006). 
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7. Usage of the X-chromosomal STRs and their characteristics 

In principle, the guidelines of the ISFG (www.isfg.org) are valid for working with 
X-chromosomal STRs, too. However, the following special characteristics 
should be pointed out: Typing of X-chromosomal markers is only permissible 
when the phenotypic and genetic sex is identical. The genetic sex can easily 
be determined by the analysis of the Amelogenin locus. If the phenotypic sex 
differs from the genotypic sex, results from ChrX-typing could not be used. 
Following the national laws, this information has to be handled strictly 
confidential and should only be forwarded to the analysed person on request. 
 
Generation of X-chromosomal profiles for kinship testing should be taken into 
account whenever autosomal markers do not give reliable or unequivocal 
results, mainly in deficiency cases. In some instances, e.g. for complex kinship 
and paternity testing, markers located on the sex chromosomes may turn out 
to be more informative than their autosomal counterparts, and the use of sex-
chromosomal markers may therefore substantially improve the efficiency of a 
kinship test. This arises from the fact that the mean exclusion chance (MEC) of 
a X-chromosomal marker is consistently larger than that of an autosomal 
marker with the same allele frequencies. 
 
 
Linkage groups 
In contrast to ealier findings (Szibor 2003b), recent studies showed (Tillmar et 
al. 2008, Machado 2009) that markers of linkage groups three (HPRTB, 
DXS10101) and four (DXS10134, DXS7423) cannot be regarded as unlinked. 
The possibility of linkage between these markers should be considered in 
calculation and interpretation of relationship tests in deficiency cases. If 
necessary both probabilities should be calculated from the linkage groups 1,2,3 
and linkage groups 1,2,4. For use and calculation of X-chromosomal markers 
see Krawczak M, 2007 and http://linkage.rockefeller.edu. 
 
 
Kinship tests and paternity cases with ChrX STRs  
X-chromosomal markers are particularly informative for inferring parent–
offspring relationships that involve at least one female, i.e. mother–daughter, 
mother–son, and father–daughter duos. For paternity cases only testing 
between father and daughter is possible, since fathers leave their only X-
chromosome to their daughter, and sons get the X-chromosome from their 
mother. 
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Deficiency cases 

If the putative father (PV) descends from the putative grandmother (PGM) 
without any doubt, his X-chromosomal characteristics originate from the PGM. 
Therefore, she (PGM) can be analysed X-chromosomally instead of him (PV). 
The calculation of the PGM-likelihood with X chromosomal markers (PGM-
daughter) may be performed like the calculation with autosomal markers (PV-
daughter). Here, the MEC values according to the formula of Krüger et al., 
1968 shall be applied, whereas only unlinked X-STR markers of the Mentype 
Argus X-8 can be used. For markers which are in coupling equilibrium, 
haplotype frequencies must be involved for calculation.  
 
 
Siblings and distant relationships 

The X-chromosomal analysis – without parental samples – can not be used as 
relationship test in the following cases: 
- Different putative fathers could be father of the child  
- Half-brothers with same father and different mothers  
- Brothers and half-brothers with same mother (statistically, they have  
  50% of the characteristics in common, thus the test is comparable to a test   
 with autosomal markers)  
 
Whenever distant relationship should be analysed, genotyping of X-
chromosomal markers is very useful, because the usage of coupled markers 
allows ChrX-haplotyping. Three markers of each linkage group from Mentype® 
Argus X-8 have to be handled as haplotype for genotyping. For further details 
see Szibor et al., 2003b, for calculation see the online data base “ChrX-
STR.org” (http://www.chrx-str.org). 
 
 
Usage of X-chromosomal markers for forensic traces 

In most cases the use of autosomal markers for profiling is much better 
because all autosomal loci have two alleles. Whenever female DNA traces have 
to be analysed in a male background, e.g. female traces under nails of a man, 
X-chromosomal markers are advantaged. The likelihood that one allele of the 
trace is covered by the male background is only half in comparison to 
autosomal tests. Note: International DNA databases usually do not include 
markers of the X-chromosome.  
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